1. Source Code Billing Game PlayStation

a. Form Login

Imports System.IO.Ports
Imports System.Threading

Public Class Forml

Private Sub Forml_Load(sender As System.Object, e
As System.EventArgs) Handles MyBase.Load
ProgressBarl.Hide()

End Sub

Private Sub Buttonl_Click(sender As System.Object,
e As System.EventArgs) Handles Buttonl.Click
If TextBox1l.Text = "12" And TextBox2.Text =
"12" Then
Timer5.Start()
ProgressBarl.Show()
Else
If TextBox1l.Text = "" And TextBox2.Text =
"" Then
MsgBox(" Masukkan Nama & Password
Anda", MsgBoxStyle.Critical, "Error")
Else
If TextBoxl.Text = "" Then
MsgBox("Masukkan Nama Anda",
MsgBoxStyle.Critical, "Error")
Else
If TextBox2.Text = "" Then
MsgBox("Masukkan Password
Anda", MsgBoxStyle.Critical, "Error")
Else
MessageBox.Show("Nama Atau
Pasword Anda Salah Broo", "Error",
MessageBoxButtons.OK, MessageBoxIcon.Error)
End If



End If
End If
End If

End Sub

Private Sub Timer5_Tick(sender As System.Object, e
As System.EventArgs) Handles Timer5.Tick
ProgressBarl.Increment(35)
If ProgressBarl.Value = ProgressBarl.Maximum
Then
Timer5.Stop()
SerialPortl.PortName = ("coml2") 'change
com port to match your Arduino portSerialPortl.Close()
SerialPortl.BaudRate = 9600
SerialPortl.DataBits = 8
SerialPortl.Parity = Parity.None
SerialPortl.StopBits = StopBits.One
SerialPortl.Handshake = Handshake.None
SerialPortl.Encoding =
System.Text.Encoding.Default 'very important!

MsgBox("Selamat datang Di My PS Control")
Form2.Show

End If
End Sub

Private Sub Button2_Click(sender As System.Object,
e As System.EventArgs) Handles Button2.Click
Close()
End Sub

Private Sub Timer4_Tick(sender As System.Object, e
As System.EventArgs) Handles Timer4.Tick

End Sub



Private Sub Label4 Click(sender As System.Object, e
As System.EventArgs) Handles Label4.Click
End Sub

Private Sub Label3_Click(sender As System.Object, e
As System.EventArgs) Handles Label3.Click

End Sub

Private Sub Label6_Click(sender As System.Object, e
As System.EventArgs) Handles Label6.Click

End Sub
End Class



b. Form Billing

Imports System.IO.Ports
Imports System.Threading
Public Class Form2

Shared _continue As Boolean
Shared _serialPort As SerialPort
Dim tspn As New TimeSpan

Dim pinout4 As Boolean = True
Dim pinout5 As Boolean = True
Dim pinout6 As Boolean = True
Dim pinout7 As Boolean = True
Dim ts As TimeSpan

Dim result As String

Dim Write As MsgBoxResult

Private Sub Mulail Click(sender As System.Object, e
As System.EventArgs) Handles Mulail.Click
If IsNumeric(TextBox1l.Text) AndAlso
CInt(TextBox1l.Text) > © Then
tspn = New TimeSpan(@, CInt(TextBoxl.Text),

0)
Timerl.Enabled = True
Labell.Enabled = True
Pausel.Enabled = True

Stopl.Enabled = True

SerialPortl.0pen()

If pinout4 = True Then
SerialPortl.Write("1")
SerialPortl.Close()
Timer4.Enabled = True

End If

Else : MessageBox.Show("Set waktunya dulu
Broo", "Error", MessageBoxButtons.OK,
MessageBoxIcon.Error)



End If
End Sub

Private Sub Stopl_Click(sender As System.Object, e
As System.EventArgs) Handles Stopl.Click

Timerl.Enabled = False

Labell.Enabled = False

Pausel.Enabled = False

SerialPortl.Open()

If pinout4 = True Then
SerialPortl.Write("5")
SerialPortl.Close()
Stopl.Enabled = False

End If

End Sub

Private Sub Stop2_Click(sender As System.Object, e
As System.EventArgs) Handles Stop2.Click

Timer2.Enabled = False

Label2.Enabled = True

Pause2.Enabled = False

SerialPortl.Open()

If pinout5 = True Then
SerialPortl.Write("6")
SerialPortl.Close()
Stop2.Enabled = False

End If

End Sub

Private Sub Mulai3_Click(sender As System.Object, e
As System.EventArgs) Handles Mulai3.Click
If IsNumeric(TextBox3.Text) AndAlso
CInt(TextBox3.Text) > © Then
tspm = New TimeSpan(@, CInt(TextBox3.Text),

o)
Timer3.Enabled = True
Label3.Enabled = True
Pause3.Enabled = True

Stop3.Enabled = True



SerialPortl.0Open()

If pinout6 = True Then
SerialPortl.Write("3")
SerialPortl.Close()

End If

Else : MessageBox.Show("Set waktunya dulu
Broo", "Error", MessageBoxButtons.OK,
MessageBoxIcon.Error)

Timer4.Enabled = True
End If
End Sub

Private Sub Stop3_Click(sender As System.Object, e
As System.EventArgs) Handles Stop3.Click

Timer3.Enabled = False

Label3.Enabled = False

Pause3.Enabled False

SerialPortl.0Open()

If pinout6 = True Then
SerialPortl.Write("7")
SerialPortl.Close()
Stop3.Enabled = False

End If

End Sub

Private Sub Pausel_Click(sender As System.Object, e
As System.EventArgs) Handles Pausel.Click
Timerl.Enabled = False
Lanjutl.Enabled = True
SerialPortl.0Open()
If pinoutd4 = True Then
SerialPortl.Write("5")
SerialPortl.Close()
Pausel.Enabled = False

End If
End Sub



Private Sub Lanjutl_Click(sender As System.Object,
e As System.EventArgs) Handles Lanjutl.Click

Timerl.Enabled = True

Pausel.Enabled = True

SerialPortl.Open()

If pinout4 = True Then
SerialPortl.Write("1")
SerialPortl.Close()
Lanjutl.Enabled = False

End If

End Sub

Private Sub Pause2_Click(sender As System.Object, e
As System.EventArgs) Handles Pause2.Click

Timer2.Enabled = False

Lanjut2.Enabled = True

SerialPortl.Open()

If pinout5 = True Then
SerialPortl.Write("6")
SerialPortl.Close()
Pause2.Enabled = False

End If

End Sub

Private Sub Lanjut2_Click(sender As System.Object,
e As System.EventArgs) Handles Lanjut2.Click

Timer2.Enabled = True

Pause2.Enabled = True

SerialPortl.Open()

If pinout5 = True Then
SerialPortl.Write("2")
SerialPortl.Close()
Lanjut2.Enabled = False

End If

End Sub

Private Sub Pause3_Click(sender As System.Object, e
As System.EventArgs) Handles Pause3.Click
Timer3.Enabled = False
Lanjut3.Enabled = True



SerialPortl.0Open()

If pinout6 = True Then
SerialPortl.Write("7")
SerialPortl.Close()
Pause3.Enabled = False

End If

End Sub

Private Sub Lanjut3_Click(sender As System.Object,
e As System.EventArgs) Handles Lanjut3.Click

Timer3.Enabled = True

Pause3.Enabled = True

SerialPortl.0Open()

If pinout6 = True Then
SerialPortl.Write("3")
SerialPortl.Close()
Lanjut3.Enabled = False

End If

End Sub

Private Sub Form2_Load(sender As System.Object, e
As System.EventArgs) Handles MyBase.load
SerialPortl.PortName = ("coml2") 'change com
port to match your Arduino portSerialPortl.Close()
SerialPortl.BaudRate = 9600
SerialPortl.DataBits = 8
SerialPortl.Parity = Parity.None
SerialPortl.StopBits = StopBits.One
SerialPortl.Handshake = Handshake.None
SerialPortl.Encoding =
System.Text.Encoding.Default 'very important!
Timer4.Enabled = True
Labeld.Text = TimeOfDay
End Sub

Private Sub Mulai2 Click_1(sender As System.Object,
e As System.EventArgs) Handles Mulai2.Click
If IsNumeric(TextBox2.Text) AndAlso
CInt(TextBox2.Text) > @ Then



ts = New TimeSpan(@, CInt(TextBox2.Text),
0)

Timer2.Enabled = True

Label2.Enabled = True

Pause2.Enabled = True

Stop2.Enabled = True

SerialPortl.Open()

If pinout5 = True Then
SerialPortl.Write("2")
SerialPortl.Close()

End If

Else : MessageBox.Show("Set waktunya dulu
Broo", "Error", MessageBoxButtons.OK,
MessageBoxIcon.Error)

Timer4.Enabled = True
End If
End Sub

Private Sub Timer4 _Tick(sender As System.Object, e
As System.EventArgs) Handles Timer4.Tick
Labeld.Text = TimeOfDay
Mulail.Enabled = True
Mulai2.Enabled = True
Mulai3.Enabled = True
End Sub

Private Sub Timerl_Tick(sender As System.Object, e
As System.EventArgs) Handles Timerl.Tick
tspn = tspn.Subtract(New TimeSpan(@, @, 1))
Labell.Text = String.Format(" {@} Mins : {1}
Secs", tspn.Minutes, tspn.Seconds)
If tspn.Minutes = @ AndAlso tspn.Seconds = @
Then
If tspn.Seconds = @ < 1 Then
Timerl.Enabled = False
SerialPortl.0Open()
If pinoutd4 = True Then
Timerl.Enabled = False
SerialPortl.Write("5")



SerialPortl.Close()
MsgBox(" P S 1 SELESAI ")
End If
End If
End If
End Sub

Private Sub Timer2_Tick(sender As System.Object, e
As System.EventArgs) Handles Timer2.Tick
ts = ts.Subtract(New TimeSpan(@, 0, 1))
Label2.Text = String.Format(" {0} Mins : {1}
Secs", ts.Minutes, ts.Seconds)
If ts.Minutes = @ AndAlso ts.Seconds = @ Then
If ts.Seconds = @ < 1 Then
Timer2.Enabled = False
SerialPortl.Open()
If pinout5 = True Then
SerialPortl.Write("6")
Timer2.Enabled = False
SerialPortl.Close()
MsgBox(" P S 2 SELESAI ")
End If
End If
End If
End Sub

Private Sub Timer3_Tick(sender As System.Object, e
As System.EventArgs) Handles Timer3.Tick
tspm = tspm.Subtract(New TimeSpan(@, 0, 1))
Label3.Text = String.Format(" {0} Mins : {1}
Secs", tspm.Minutes, tspm.Seconds)
If tspm.Minutes = @ AndAlso tspm.Seconds = @
Then
If tspm.Seconds = @ < 1 Then
Timer3.Enabled = False
SerialPortl.Open()
If pinout6 = True Then
SerialPortl.Write("7")
Timer3.Enabled = False
SerialPortl.Close()



MsgBox (" PS3 SELESAI ")
End If
End If
End If
End Sub

Private Sub Timer5_Tick(sender As System.Object, e
As System.EventArgs) Handles Timer5.Tick
Label5.Text = Label5.TextAlign
End Sub

Private Sub Label5 Click(sender As System.Object, e
As System.EventArgs) Handles Label5.Click

End Sub
End Class



a. Script Tombol Mulai

Private Sub Mulail_Click(ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles mulail.Click

If IsNumeric(TextBox1.Text) AndAlso
Clnt(TextBox1.Text) >0 Then

tspn = New TimeSpan(0, ClInt(TextBox1.Text), 0)
Timerl.Enabled = True

Else : MessageBox.Show("Set waktunya dulu Broo", "Error",

MessageBoxButtons.OK, MessageBoxIcon.Error)

SerialPort1.0pen()

If pinout4 = True Then
SerialPort1.Write("4 on")
SerialPort1.Close()

Timer4.Enabled = True

End If

End If

End Sub



b. Script Tombol Stop

Private Sub Stop1_Click(ByVal sender As System.Object, ByVal e
As System.EventArgs) Handles stopl.Click

Timerl.Enabled = False

stopl.Enabled = True

Labell.Visible = True

SerialPort1.0pen()

If pinout4 = True Then
SerialPortl.Write("4 off")
SerialPort1.Close()

End If

End Sub



c. Script Tombol Pause

Private Sub Pausel Click(sender As System.Object, e As
System.EventArgs) Handles Pausel.Click

Timerl.Enabled = False
Lanjutl.Enabled = True
SerialPort1.0pen()

If pinout4 = True Then
SerialPort1.Write("'5")
SerialPort1.Close()
Pausel.Enabled = False

End If

End Sub



d. Script Tombol Lanjut

Private Sub Lanjutl_Click(sender As System.Object, e As
System.EventArgs) Handles Lanjutl.Click

Timerl.Enabled = True
Pausel.Enabled = True
SerialPort1.0pen()

If pinout4 = True Then
SerialPort1.Write("1")
SerialPort1.Close()
Lanjutl.Enabled = False

End If

End Sub



e. Script Code For Arduino

//BY Agung

//

int led3=3;

int led4=4;

int led5=5;

int led6=6;

{
Serial.begin(9600);
pinMode(led3,0UTPUT);
pinMode(led4,0UTPUT);
pinMode(led5,0UTPUT);
pinMode(led6,0UTPUT);

}

void loop(){
while(Serial.available()==0);
int val=Serial.read()-'0';

if(val==1){
Serial.printin("4, ON");digitalWrite(led4, HIGH);
}
if(val==2){
Serial.printIn("5, ON");digitalWrite(led5, HIGH);
}
if(val==3){
Serial.printin("6, ON");digitalWrite(led6, HIGH);
}
if(val==4){
Serial.printIn("3, ON");digitalWrite(led3, HIGH);
}

else if(val==5)



{

Serial.printin("4, OFF");digitalWrite(led4, LOW);
}
else if(val==6)
{

Serial.printin("5, OFF");digitalWrite(led5, LOW);
}
else if(val==7)
{

Serial.printin("6, OFF");digitalWrite(led6, LOW);
}
else if(val==8)
{

Serial.printin("3, OFF");digitalWrite(led3, LOW);
}
}



Arduino Uno R3
A. Schematic
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B. DataSheet Arduino Uno R3

Arduino

s ARDUINO

o)
“ q-..-..._‘.." bemass

Product Overview

The Arduino Uno Is 3 microcontrolier board based on the ATmega32s (datasheat) It has 14 digtal
Inputioutput pins (of which 5 can be usad 3s PWM outputs), GmabgllvmaﬁMqumosdmnr a
USE connection, 3 power Jack, an ICSP header, and a reset button. It contains evenything needad to
support the microcontroller; imply connact It to 3 computer with 3 USB cadie of power | we 3 AC-10-DC
adapier of battery to get started. The Uno differs from all precading DOAras In that It does not use the FTDI
USEB-to-senal driver chip. Ins2ad, & fetures the AimegaBU2 programmed as 3 USS-to-sertal converter.

"Uno™ means one In Rallan and is named 10 mark e upcoming ralaase of Arduino 1.0. The Uno and version
1.0 wil be the referance versions of Arduno, moving forward. The Uno is the latest In a seres of USE
Arguino boards, and the referance mode! for the Arduino piatform; for 3 CoOMpanson with prRVIOUs versions,

see the Ingex of Aruino Dogrds.

e ndex.
miz'ﬂons Page 2
Howtouse Arduino Page 6

E’me%m Page 7

e Page 7
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Technical Specification

EAGLE fem 20 2 promt praey a
Summar
Mcrocontroiler ATm=ga328
Operating Voitage sv
Input Vioitage recommended) 7-12V
Input Voriage (imits) 620V
Digital VO Pins 14 (of which & provida PWM ouput)
Analog Input Pins 6
DC Cumant par 1O Pin OmA
DC Cument for 3.3V Pn samA
32 KB of which 0.5 KB usad by
Fiaeh Mooy boctioader
SRAM 2KB
EEPROM 1KB
18 MHz
the board

"Test”
ed 13

NADE
INITALY 2

B o)

RSN, (2nalog pins|
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Power
The Ardulng Uno can be powered via the USE connection of with an extemal power supply. THe Dowsr
SDUMCE [ Ssiectag automatically.

Extamal (non-USH) power can come either $om an AC-0-DC adapier (wal-wart) or battery. The adapier
3N be connectad 3 2.1 center-gosiive pug nfo M DUSITTs pOWer jack. Leads from 3
mymbelmgm nganumuvnpmheaummlﬂe R s

The board £an operate o 3N Sxbemal SUpply 0f 510 20 VLS. 1f SUPRSd Wi 1255 than 7V, howsver, hie 5V
BN miay suDply 1265 than flve woits and the board may be unstable. I Lsing mors than 12V, Me voltage
FEguizior may overmeat and damage the boam. The recommended range s 7 10 12 voits.

TMi pOWET PiNG a2 35 Tolows:

= VIN. The Input voltage to e Arduing board when 5 using an extemal power source (35 opposed fo
S voits from the WSS connection or other reguiaied power SOUMCE). You can sUDply voitage through
this pin, or, I supgiying vofiage via the power [ack, accass | througn this pin.

« 5. The requiated power supply 1sed to power the microconirolier and other components on the
Do, ThiS C3N come fNer Som VIN via an on-board reguiator, of ba supplied by USE of anomer

reguiat=d SV SLRDlY.
« 3V A 3.3 voit supply generated by the on-board raguiator. Maximum current draw s SO ma.
»  GHD. Grownd phs.
The Siofng ood (of i 0. K < usea for he otoacer,
T 40 ThE o St %mm%m}:aaummmmsEM|

Input and Output

Each of the 14 dighial pins on the Uno can be usad a8 an Input or outpus, using pinbdode(), dighaiwmal), and
AgtalREa() fncions. They operate & S volts. E3ch pin £3n provioe of necive 3 MaXmUm of 40 mA, ard
n3s an Imemal puil-up resistor [disconnectad by cefault) of 20-50 kOhms. In additlon, some ping have
spadallzed funciions:

«  Serial: 0 (R and 1 [TX). Used io recatve (FC) and transmit {Tx) TTL seral data. TThesa pins are
connected to e comesponding pins of the ATMEgaEL? USEHD-TTL Seral chip .
»  Extemal Intsrrupés: 2 and 3. These pins can be configured to rgger an Intemupt on a low value, 3
rising or fallrg edge, or 3 change In value. Sae the aiachintempd! function for detalls.
M&S.B,S.1D.“11 Prowide B-Dit PYWM oLRput with T2 angloginted) funcion.
110 [55), 11 (MOSH, 12 MISO) 13 ﬂm These pins suppart SPI communication, which,
provided by the underying hardware, ks not cumently Included In the Amulng Enguage.

* LED: 13. Them ks 3 bult-in LED conneciad 10 digital pin 13. When the pin Is HIGH value, me LED ks
on, when the pin is LOW, ICs off.
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The Uno has & anaiog Inpuis, each of which provide 10 bis of resolution {Le. 1024 difesent walues). By
defaut from [ Is I posslbie o the upper and of thel
(Eng e AREE o Ee mE analaTRErErence]] ntian ASSROnal. some fne nave Spesais

« PC:4(SD4) and 5 [SCL]. Support FC [TWI) communication using the Wirs Ibmny.
There are 3 couple of oiher pins on i boart

«  AREF. Refarence voltage for the analog Inputs. Used with anaiogReEtsrence().
« Reest Bring this line LOW to reset the migrocontroler. Typlcally used to add a resst buton fo
shigits which biock the one on the Doand.

Communication

The Arduing Uno has a number of faciities: for communicating Wil 3 COMpLUtEr, andther Arduind, or omer
microcontrilers. The ATMmegalas provides LART TTL (V) sarial communication, which is avallabie on

COM drivers, and no external driver ks needad. However, mmnﬂmm Inf fle = reguired..

The Arduing software Ingiudes a sarial manitor which allows simpls textual d5ta to be sent to and from the
Amuing baand. The R and TX LEDS on the board wil fiash when data ks baing Fansmitted via the USE-D-
senal chip and LS connection 10 e computer (DUt Not for s2nal communksiian on pins 0 and 1).

A SoftwareSedal Inmry sllows for serial communication on amy of the Uing's digital pins.

P.TIT?KZ EGHWIlMuHWDfLTMN‘III o SOMAGIE INCIUdEs a Wire
IIDIEI')'1D I.IBEI:‘ sea the documentaton for detals. To use Te 5P communication

Programmini

The Amuing UNg can be programmed wih Me Amuing sORWare [Cownioad). Select “ATUND Lng wi
ATMega3Is” from the Tools = Board meny {ccoming to the microcontrolier on Your baand). For datalls,
5= the relemnce and fulodals

The ATmega3zd on the Anduine Uino comes prebumed with 3 boobioader that allows you to upload new code
0 I without the use of an exemal hamware programmer. | communicates using the onginal STRS00
profocol (erence, C heaged fles).

You can also bypass the bootioader and DI the microconirolier through e ICSP (In-Circult Senal
Programiming) header; see (hese instnudlions for detlls.

The ATmegasi? SMTWare Souce cooe is avallatie . The ATMega3Uz ks loaced win 3 DFU bootigader,
which can be activated by conneciing the soidar jumper on e back of the board (near the map of Faly) and
Men reseting the SU2. You can hen use Almel's FLIP sofivware (Windows) of e DFU programmes (Mac
05 X and Linu) to load a new frmwane. O you can use the ISP header with an extemal programmer
{versting the DFU bootoader).

@ M radiospares RADIONICS ‘g-



Automatic (Software] Reset

Rather than raquiring 3 physical prass of Ma reset bution bafore an upload, the Ardulng Uno Is designed In
wayy that allows 1t to be raset by software running on 3 connacted computer. One of he handware fiow control
lInés. (DTR} of the ATMeqaEll? ks connectad to the recat Ine of the ATMmegalls Wia a 100 nanofarad
capaciior. When tis line Is assariad (laken low), M recet In2 drops long enough to resat the chip. The
AN SOFWETE USEE this capabillty 10 3Bow YOU b UF0ad code by Smply Fressing Me upload buson in the
AmUING ervranment. THS Maans Mat he BOOINANET £3N Nave 3 Shanar IMRoL, a8 e iowenng of OTR
£ he Wl-COOMINGte Wit the Stan of ta umoan

This 56D has oier Implications. When the Uno is connected 1 elther 3 computer rumning Maz OS X of
Lira, It FREELS £3Ch BMS 3 CONNECHOn ks M3a (o It from soffware (W3 USE). For the folowing halt-sacond of
50, the bootoaser |5 running on Me Una. Wile It 15 programmed i ignore maliormed o33 (Le. anying
beskles an upload of new code), i will Inament the first few bytes of dafa sent fo the boand afer a
conneciion Is.opened. I a skeich nunning on the board receives one-time configuration or other data when it
frs slans, make swe (at e softwaE win wiich [t communicalss walis 3 second after opening the
connection and before sendng this daa.

The Uno contains a frace Mal can be cul o disabie the auipeset. The pads on efther side of the ace can

o2 soigened together bo re-enabie it It's labeled "RESET-EN. You may also be a2 o disable the auin-esst
[y connecing a 110 ohm resistor from 3 o the reset Ine; see for detalls.

USB Overcurrent Protection

The Amuino Una has 3 ressbiable polyluse that projects your computers USS ports from shorts and
overcument. Although most computers provide thelr own Iniemal protection, he Tuse provides an exina layer
af . It mone than 500 méA s appiled to the LUISE port, the fuse will automatically break the connection

| the shor or overioad s

Physical Characteristics

The maximum length and widh of the Uno PCS ame 27 and 2.1 Inches respeciively, with e LSS connector
and power |ack exaendng beyond Me fumer dmension. Three screw hoies alow Mie board o be attached o
a surface of case. Note that the distance between digial phs 7 and 3 Is 160 mil (0,157}, not an even mutipie
of the 100 mil sacing of the oiher pins.
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How to use Arduino

Arduing ¢an sense the environment by recelving Input from a varlety of sensors and can affect its
surroundings by controlling lights, motors, and amer actuators. The microcontrolier on the boand ks
programmed using the Arduing programming language (oased on Wiing) and the Arduing
development envirenment (pased on Processing). Ardulng projects can be stand-alone or they can
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Argulng Is 3 cross-platoform program. You'll have to Toliow differsnt Instructions for your personal
05, Check on the Arduino sie for the latest Instructions.  hitpcYariung coen'GuideHomePage

Linux Install Mac Install

Cnea you have downkiadediurzipoed D arduing IDE, you £3n Plug the AFLnG to your PC via USE ok

Naw you're actualy ready 1o "bum® your
frst program on the amuino board. To
salect “biink led”, the physical transiation
of Me wel Known programming “hedo
word™, salect

File>Sketchbook>
Arduino-0017>Examples> it et
Digital>Blink 2o lladtin, WATENTI S
Once you have your skecth you'll
see something very close to the
screenshot on the nght. N

In Tools>Board select cLisclectin.

how you have to go to
Tools>S5erialPort

and select the nght senal port, the
one arduine is attached to.
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Dimensioned Drawin
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Terms & Conditions

1 Wersantes

19 The producer warmanis sk B prociucis wil conr, io fe Speciloaiions. This warany s e ons 1) psan from e dais of e s T
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Philips Semiconductors Product specification

Quad bilateral switches T4HC/HCT4066

FEATURES The T4HC/HCT4066 have four independent analog
switches. Each switch has two inputioutput terminats (n'y,

+ Very low "ON" resistance: nZ) and an active HIGH enable input (nE). When nE is

50 € {typ-) at 45 = 2 inp
450 (typ.) at 80V LOW the belonging analog switch is tumed off.
350 {typ)atVee =00V The "4066” is pin compatible with the “4016” but exhibits a

rnuch lower "ON” resistance. In addition, the "ON"
resistance is relatively constant over the full input signal
= Iz category: SSI. range.

» Dutput capability: non-standard

GENERAL DESCRIFTION

The T4HC/HCT4066 are high-speed Si-gate CMOS.
devices and are pin compatible with the "4066° of the
“4000B" series. They are specified in compliance with
JEDEC standard no. TA.

QUICK REFERENCE DATA
GND=0V; Tamp =25°C:t,=t,=6ns
TYPICAL
SYMBOL CONDITIONS UNIT
HC | HCT
tazn! tezL turm-on time CL=18pF R =1k Vg =5W | 11 12 ns
e tez turn-off time nE to Wy, 13 16 ns
[+ input capacitance 35 |35 |(pF
Cen power dissipation capacitance per switch | notes 1and 2 1 12 pF
Cg max. switch i a g8 pF
Notes

Cpp is used to determine the dynamic power dissipation (Pp, in pW):
3) Pp=Cpp = Vge? % §+  {{CL + Cal % Vigg? = £} where:
b} fi = input frequency in MHz
¢} T, = output frequency in MHz
d) E Gy + Ca) = Wge? = £} = sum of outputs
e} Ty = output load capacitance in pF
f} Cz = maximum switch capacitance in pF
g) Vec = supply voltage in V'
2. For HC the condition is V), = GND to Vi
For HCT the condition is V) = GND ta Vge - 1.5V



Philips Semiconduciors

Product specification

Quad bilateral switches T4HC/HCT4066
ORDERING INFORMATION
TYFE PACKAGE
NUMEER NAME DESCRIPTION VERSION
T4HC40S5 CIP14 plastic dual indline package; 14 leads (200 mil) S0TaT-1
T4HCADEE 5014 plastic small outline package; 14 leads: body width 2.2 mm SOT108-1
T4HCA0GE SS0P14 plastic shrink small outline package; 14 leads; body width 5.3 mm SOT337-1
T4HCAODGE TS30P14 | plastic thin shrink small cutiine package: 14 leads; body width 4.4 mm | SOT402-1
T4HCT4066 DIF14 plastic dual indline package:; 14 leads (200 mil} SOT271
T4HCT4066 5014 plastic small outline packags; 14 leads; body width 2.2 mm SOT108-1
TAHCT40E86 S50P14 plastic shrink small outline package; 14 leads; body width 5.3 mm SOT337-1
T4HCT4066 TS30P14 | plastic thin shrink small cutline package: 14 leads; body width 4.4 mm | SOT402-1
FIN DESCRIFTION
FiIN NO. SYMBOL MAME AND FUNCTION
1.4.8 11 1 to 4 independent inputs/outputs
2,3.8.10 1ZtodZ independent inputs/outputs
7 GMD ground (0 V)
13, 5.6, 12 1Etn4E enable inputs (active HIGH)
14 Voo positive supply voltage
o Y e el el
'ZE EI = 1Z[—2
- — . | zr|—s
=[] [=]+= == zl—3
3] aoee [T er
=[E] ] = £—3E
=[E] [e= 12—
anp [T BE;: el I
wsezny waRzed
Fig.1 Fin configuration. Fig-2 Logic symbaol.
18828 Nov 10 3



Philips Semiconductors

Product specification

Quad bilateral switches TAHC/HCTA066
a2
- 4 3
==
2
] L]
- £ =
1 i
2z
o)
a.
Fig.2 |IEC logic symbol.
FUNCTION TAELE
INFUT NE SWITCH
L off
H on
Note
1. H=HIGH voltage level; L = LOW voltage level.
2 1|5 |5 |5 |®
1 [1r [2E [or 2= Jav
i
1z az 2
Iz I 15}

Fig.4 Functional diagram.

-
n

nZ  waRzse

Fig.5 Schematic diagram {one switch).
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Philips Semicomduciors Product specification

Quad bilateral switches T4HC/HCT4066

RATINGS

Limiting walues in accordances with the Abzolute Maximumn System (IEC 134) Voltages are referenced to GHD
(GMND =Dy

SYMBOL PARAMETER MIN. [ MAX. | UNIT CONDITIONS

Voo DC supply voltage -0.5 (+110 [V

e [ digital input diode current 20 mA |for¥,=— 0.5V arV, = Veg - 05V

o DT switch dicde current 20 mA  |forWs=-05Varvy s Veg 05V

g DC switch current 25 mA  |for 05V <Vg<Vog+ 05V

Heg, DG Wer or GHND current 50 mé

laam

Tusg storage temperature range -85 (+150 C

Pt power dissipation per package for temperature range: 40t +125°C

TAHC/HCT

plastic DIL 750 mW abowe +70 "C: derate linearly with 12 milbiK
plastic mini-pack (S0} 500 v above +70 "C: derate linearly with 3 mWIK

Pz poweer dissipation per switch 100 mW

Note

To avoid drawing V-, current out of terminal nZ, when switch cument flows in terminal n'Y, the voltage drop across
the bidirectional switch must not exceed 0.4 V. If the switch curent flows into terminal nZ, no Vo curment will flow
out of terminal nY. In this case thers iz no limit for the voltage drop across the switch, but the voltages at nY and nZ
may not excesd Voo or GMND.

RECOMMENDED OPERATING CONDITIONS

T4HC T4HCT
SYMBOL PARAMETER UNIT CONDITIONS
min. | typ. | max. | min. | typ. | max.
Ver DC supply voltage 20 |50 (100 |45 50 |56 (v
v DC imput voltage range GND Vgo | GND Veg [V
Wy DC switch voltage range GMND Voo | GND Wee [V
Tamb operating ambient 40 #25 (40 +85 C see DC and AC
tempersture rangs CHARACTERISTICE
Tamb operating ambient 40 +125 |-40 +125 ["C
tErmperature rangs
te by input rise and fall times 6.0 | 1000 60 |500 |ns Vg =20V
500 Vee =48V
400 Vo =60V
250 Ve =10.0Y

1888 Mov 10 5



Philips Semiconduciors

Product specification

Quad bilateral switches

T4HC/HCT4066

DC CHARACTERISTICS FOR T4HC/HCT

For T4HC: Vge = 2.0, 4.5, 6.0 and 8.0 V; For T4HCT Ve =45V

Tams "C) TEST CONDITIONS
TAHCIHCT
SYMEOL PARAMETER +25 —40 to +85 | —40 to +125 UNIT Ve | 15 Vis | W
- - - ) (A R
min. | typ. | max. | min_ | mac. [ min. | max.
Rom ON-resistance (peak) - - - - ¥l 20 1100 | Voo |Ve
54 |05 118 142 |0 45 |1000 |t ar
42 |84 105 126 |2 6.0 | 1000 GND | Ve,
22 |70 Ba 105 |0 8.0 | 1000
Ron OM-resistance (rail) 80 |- - - iyl 20 |100 | GMND | Ve
a5 |78 a5 15 |0 4.5 | 1000 ar
27 |85 ez 00 |0 8.0 | 1000 Vo
20 |55 T as Q2 8.0 | 1000
Ron OM-resistance (rail) 100 |- - - i+l 20 100 Voo |Ve
42 |80 106 128 |0 4.5 | 1000 ar
a5 |78 o4 13 |2 6.0 | 1000 Vo
27 |80 7a o5 0 6.0 | 1000
ARow maximum variation of - ¥l 20 Vee |Vs
OMN-resistance between 5 0 45 1o or
any two channels 4 a a0 GMD [V
2 0 8.0
HNote

At supply voltages approaching 2 V| the analog switch OM-resistance becomes extremely non-inear. Thersfore it is
recommended that these devices be used to transmit digital signals only, when using these supply voltages.

1883 Nov 10




Philips Semiconduciors. Product specification

Quad bilateral switches TAHC/HCT4066
HISH [
I*rom enabie Inputs) [
ny rz
Vig = Do v -GN () [:> s
GND
- MR

Fig.§ Test circuit for measuring OM-resistance (Ray).

from er_abz Inputs)
nr l nz
V= Vi orohD —(A} [ ] {A)— Vg=oNDerigy

GND
; [ELE

Fig.7 Test circuit for measuring OFF-state current.

HIGH
o enabie Inputs) _D
Y nz
V= Vg g or GND ——{&} {A)— Vo lopen crouty
GND
* wamzss

Fig.8 Test circuit for measuring OMN-state cument.
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